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Why Use the TriSys Browser Extension

e Compatible with LinkedIn Free and LinkedIn Recruiter

e Streamlined business development and contact management

e Streamlined client and candidate database management

e Enrich your TriSys contact database with Linkedin contact information

e Overlay of key CRM/ATS contact details directly within Linkedin profile
pages

e Faster and more informed decision-making, less mistakes and greater
accuracy

¢ Running action workflows directly from within LinkedIn profile pages

e Saving time and money on a daily basis, increasing your operational
returns

The TriSys browser extension works with the latest version of Google Chrome and
has also been successfully tested on Microsoft's latest Edge web browser which
runs on the Google Chromium open source web browser engine.

Install the Extension

Click here: https://chrome.google.com/webstore/search/trisys

Next, click the blue button “Add to Chrome”

£~ chrome web store £ Signin
trisys Extensions 10of 1 extensions
« Home
(O Extensions Tr'\Sys
QO Themes Offered by: https:/frecruitment trisys.co.uk
‘Add to Chrome
Features - Integration with TriSys Recruitment CRM/ATS Database.
O  Runs Ofine % %%k &k 11 Productivity
O By Google

Click “Add Extension”

£ chrome web store Add "TriSys"? & signin

It can:

Home > Extensions > TriSys Read and change your data on all linkedin.com sites and
mail.geagle.com

= Read your browsing history A
n TriSys ! ansten Checking...
= )
Offered by: https://recruitr] Add extension ﬂ

W % % % % 11 | Produc|

The extension will now be installed, this is clear by the presence of the TriSys icon
at the top right:
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X g ChromeWeb Store-trisys X = = = X

ax ooc[m]e:
X

! “ TriSys has been added to Chrome

Use this extension by clicking on this icon.
H Manage your extensions by clicking Extensions in the

Tools menu.

To get your extensions on all your computers, turn on sync

Once the Extension is visible, you will need to open any Linkedin profile page (for
example your own LinkedIn profile page).

Next, click the TriSys icon. You will see the following pop-up window, where you will
click “Connect”

# @@ oM\

L Trisys

Trisys Add-

This component allows you to connect any application (e.g. Microsoft Office, LinkedIn,
Google Mail etc..) to TriSys Cloud.

You will thus be able to import e-mails, contact/company/job details directly into TriSys,
as well as lookup contact/company details when viewing incoming e-mails, or pull/lockup
data from a variety of sources directly into this component for your ultimate
convenience.

TriSys is a suite of sophisticated business sofware tools running in a global cloud
computing system allowing you access to your data from any device (maobile phone,

tablet, PC, smart speaker), at any time.

Please click the connect button below to submit your credentials, or learn more or sign-

up to our services.

@ Learn More / Sign-Up

Once you click you will need to authenticate using your existing TriSys
username and password.

e For cloud hosted TriSys Customers, this will be your existing TriSys
username and password

e For TriSys Customers with an onsite database server deployment, please
contact your local TriSys database administrator, who will then contact
support@trisys.co.uk requesting that you are authorized to login and use
the TriSys Browser Extension (when this happens you will be provided with a

link to set a password, which you then use in combination with your work e-
mail address)
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* (@ 5 B Should you see the message
below, your username/password
TriSys Add-In either does not match our
This component allows you to connect any application (e.g. Microsoft Office, LinkedIn, l‘eCOI‘dS (you can Ot thIS p0|nt
retry or click “Reset Password” or
your user account has not yet
been granted permission to use
the TriSys Browser Extension.

Google Mail etc..) to TriSys Cloud.

K3 Login ®

E-Mail
your-work-email@your-company.com
Password

......... { TriSys Add-In =~ %

ncorrect credentials

Login Reset Password Register Cancel

OK

Visual Functionality Overview

The TriSys browser extension allows you to visit LinkedIn profiles and import
contacts into your TriSys CRM/ATS database.

The extension also allows linking existing TriSys database contacts to their
corresponding LinkedIn profile pages, resulting in a fast, informative and very
convenient information-rich overlay when visiting LinkedIn profile pages, as
shown in the example below (the extension is activated by clicking the ® icon on
your web browser toolbar.

If the LinkedIn profile contact is already in your database, the following is the look
and feel of the extension overlay window, next to a LinkedIn contact profile:
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(D This website uses cookies to improve service and provide tailored ads. By using this site. you agree to this use. See our Cookie Policy L Trisys

T @ sesrch

Grow your business - Join thousands of web design agencies worldwide who choose Elementor xd

Promoted

O Personal Mobile
Garner Osborn
Circuits & Home Phone

9 Address

© Websie

Learn more| @ S =

Josie Musto - 1st Opus Laboris Recruitment B CVPreview v
Recruiter at Opus Laboris Recruitment ¥ University of Cambridge Learn the skills Jd & Requirements (7 R4
Cambridge, United Kingdom - 57 connections - Contact info 0-
Highlights 0 -

Q 5 mutual connections

= Niche Recruiting
% 3 @ BN Viewers: 31,019
Tlwel's

The top section of the browser extension allows you to perform the following
operations, provided that you are running TriSys:

- Open the contact (click the name or use the CRM menu)

- Open the company (if applicable) by clicking the name or use the CRM
menu

- Open social network pages (social network icons)

- Run Actions (Call, Note, Add to Shortlist, ToDo and more)

- You can also selectively update the contact with the most recent LinkedIn
data (CRM Menu)

Note: the range of displayed contact details displayed will vary depending on the
corresponding TriSys database fields having value or no value, hence you may

see more or less contact details.

=3
Josie Musto - 1st Opus Lubaris Recruitment el
Recruiter at Opus Laboris Recruitment B University of Cambridge .
Cambridge, United Kingdom - 57 connections - Contact info
o-
o-
Highlights 5
5 mutual connections - . | Tasks m -
BRI Atign Recruiting with Jab
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The original CV file can also be seen, using the “CV Preview” tab:

Josie Musto

Recruter 3t Opus Labaris Recrutment

Summary

1 am  recruter spedaising n gardening

Exper

You can also view Requirements, Placements, Notes/History and Scheduled Tasks,
together with total entries for each of these.

L Requirements ° -
£ Placements o -
il Notes/History m -
B Scheduled Tasks [0 4

Click any of the tabs to expand the contents (for example “Requirements). You
can click the requirement reference/job title and this will open the corresponding
requirement in your TriSys database (you must have TriSys running).

& Requirements Q-

L SN/Req/000655 : .net Developer
Josie Muste,

4 IM/Req/000

Kitchen Expert
Josie Musto, g2

4 JM/Req/000417 : Application Engineer
Josie Muste,

k-3 FJ/Req/001097 : Quantity Surveyor
John Adams, ABC Bank
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Add new contact from LinkedIn

It possible to add brand new contacts to your TriSys database, simply by visiting a
LinkedIn profile and adding the contact, a single click operation which saves you
time and money, increases the quality of your TriSys contact database and helps
you generate additional revenue.

When you visit a LinkedIn profile, an automatic check takes place to confirm
whether the LinkedIn profile page is already linked to an existing record on your
TriSys database.

If no link is found to exist, two options are presented:

- Add new Contact
- Assign to Existing Contact

* (@ 5\
m Q Search ¥ 5 £ ] L Trisys lin B B & v

Messaging  Notifications ~ Me [r—— e
Actor | Writer | Director | Producer | Entreprenf

Assign to Existing Contact

e
eadofyd [ Profile hepsi//www.linkedin.com/in/thejlo
= Work
% Website m
4
L Work
7] Start off W @ Location Los Angeles, California
& Home
Re|
Follow More...
[ Twicer
Jennifer Lopez @ A Nuyorican Productions Inc Unable o find a matchi cinTrisys
) enu t contact record using this
Actor | Writer | Director | Producer | Entrepreneur Learn the skills | ng contact record in TriSys.
Los Angeles, California - 30,515 followers - Contact info g i
B@E |
|
\
About
I'm a mom, partner, actor, singer, film & television producer, fashion designer, bestselling author, entrepreneur, and @ |
humanitarian. (Say that 3 times fast!) My next project "Second Act” is a funny, charming, comedy and hits theaters !
December 21. | recently completed my directorial debut of the music video for my new song, “Limitless”. I'n ... see more Script

Viewers: 1,712

I\ Linn ith Actare 2.

Normally at this point, it is best practice to click “Assign to Existing Contact” and
then specify a contact name. This will enable you to search your TriSys database
and link an existing contact in your database to the LinkedIn profile you are
currently viewing:
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& Addv @ v

X Trisys 3 share & Addv @ v

Jennifer Lopez

irector | Producer | Entrep

1

Hl Lookup Contact x

% Website http://jenniferiopez.com

5 13
M Profile hetps://www.linkedin.com/in/thejlo || [ Prodie hetps://www linkedin.com/in/thejlo
=
%
35

= Work ‘

. Work Lookup all contact recerds in TriSys which maich this name:

# Location Los Angeles, Califarnia Name Jennifer Lopez

& Home |
B3 Twister
o Unable to find a matching contact in TriSys {

Search Cancel

Use the Add menu to create a new contact record using this
profile, or assign this profile to an existing contact record in TriSys.

If no contact exists in your TriSys database which matches this LinkedIn profile,
you may proceed to clicking “Add New Contact”

L Trisys & Addv @& v

Jennifer Lopez A ew a
Actor | Writer | Director | Producer | Entreprer|
Muyorican Productions Inc Assign to Existing Contact

This will then allow you to selectively edit the Linkedin field simply by clicking the
text on the left hand side of the extension, for example under “Job Title”

e Yoy can click this text to edit the job title before adding the contact.

Note the presence of the = icons on the left hand side of the extension, which
allow you to lookup job titles, company hames and company addresses which
the imported contact should be linked to.

The chosen @ fields will be imported into the TriSys contact record when you
click the === button.
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Jennifer Lopez @

Actor | Writer | Director | Producer | Entrepreneur
a - 30,515 followers + Contact info

Los Angeles, California - 30515

About

Once you have added a new record or updated an existing record, your TriSys
database will be automatically updated in real time. This works whether you are
using the TriSys Apex browser CRM system or the TriSys CRM Windows Desktop
application edition

RECRUITMENT SOFTWARE

Associate existing TriSys database record with LinkedIn

profile

It is likely that your TriSys database already has various contacts and that some
of these do not yet have a link to their corresponding LinkedIn profile page. In such
cases you would not want to create a new contact, rather link the existing contact
to a LinkedIn profile.

If you are using TriSys Apex, you can automatically launch a LinkedIn search
which aims to find the corresponding contact. This is done using the “View” button

TriSys Business Software Ltd - Wellington House, East Road, Cambridge, CB1 1BH Page 9 of 15
Telephone: +44 (0) 1223772280 | Email: sales@trisys.co.uk | Web: www.trisys.co.uk | Data Protection: privacy@trisys.co.uk



mailto:sales@trisys.co.uk
http://www.trisys.co.uk/
mailto:privacy@trisys.co.uk

1 “-‘ ilable in tt
trisys B Lt e

Web Browser Extension

in the “Social Networks” tab of a contact record.

RECRUITMENT SOFTWARE

Choose the relevant contact and load their LinkedIn profile page. The browser
extension is designed to work within LinkedIn profile pages, which contain the
relevant contact data.

Note: if you are using the TriSys Windows Desktop Application, you will not have a
“View” button as per above image. In this case, simply type the contact
name/surname in the actual Linkedin.com search box and then open the LinkedIn
profile you wish to display.

Now that you have a Linkedin profile displayed, you can link/associate the
LinkedIn profile page to the existing contact in your TriSys database, by clicking
“Assign to Existing Contact”
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(@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Coakie Policy
Add New Contact
.
In Q Search

Never miss an update - Follow the official Cisco Training and Certification page Ad -+

M Profile hutps:/fwwew.linkedin.comiin/rbranson
= Work
% Website htps:/fwwwsirgincom/richard-branson

. Work
# Location Virgin Islands (British)

Francisco, expl{ & Home

with B
[0 Twitter

Use the Add menu to create @ new contact record using this
assign this profile 1o an existing contact record in

prof

Richard Branson - 3rd f@ & Virgin Group ‘ L
People Also Vies
Founder at Virgin Group Stowe School
Virgin Islands (British) - 16,213,590 followers - Contact info Barack
Former P
America
Y
About Jess Wh
y
| Former Pay:
Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony,
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is 2 leading Jennifer Lopez [
international investment group and one of the world's most recognised and respected brands, Since startin: ... see more
Actor | Writer | Director | Producer |

Entrepreneur

Next, type the forename and/or surname and Search. You can use either the

forename and/or surname:

* (@ B
@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Cookie Policy 1 Trisys & Addv @ Sewingsv

.
(T3 2 search

Never miss an update - Follow the official Cisco Training and Certification page 2d -

M Profile https:/fwwer linkedin.com/infrbranson

=
8 Lookup Contact x®

Lookup all contact records in TriSys which match this name:

Name Richard Branson

Ready fory

[

Search Cancel

Richard Branson - 3rd @ & Virgin Group i TR
People Also Vie
Founder at Virgin Group Stowe School
Virgin Islands (British) - 16,213,590 followers - Contact info Barack
Former P
America
~
About Jess Wh
N
{ Former Pray,
Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading Jennifer Lopez [
international investmeant group and one of the world's most recognised and respectad brands. Since startin .. see more
Actor | Writer | Director | Producer |

Entrepreneur

A list of potential matches found in your TriSys database is shown, allowing you to
choose which existing contact record should be linked to the LinkedIn profile
page. When a contact is selected (click the contact name) the link is established
between the LinkedIn profile and the TriSys database contact.

Note how, next to each contact found to match the nome/surnome combination,
you can see:

e The contact type
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e The contact ID (which can be used to easily pinpoint, using your TriSys
database and looking up this ID, whether the contact is the one you wish to
assign the LinkedIn profile to, thus eliminating any ambiguity in the process
of assigning a LinkedIn profile page to a TriSys database record)

* @ W
@ This website uses cookies to improve service and provide tailored ads. By using this site, you agree to this use. See our Cookie Policy & Addv @ Seuingsv
Richard Branson
der ot Virgin Group

Technologies Corp

Richard BRanson
! A Candidate - 50473
Accountant

Richard Branson
ceo hexi=50%6
Francisco, expll

.
in B

Virgin Music
wi

[

Unfollot

i - 3rd @ Virgin Group _
Richard Branson in] oo AoV
Founder at Virgin Group Stowe School
Virgin Islands (British) - 16,213,590 followers - Contact info Barack (
Former P
America
<
About Jess Wh
i
Former Prayouy
Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony.
travel and transportation. financial services, leisure and entertainment and health and wellness. Virgin is a leading Jennifer Lopez [
international investment group and one of the world's most recognised and respected brands. Since startin: ... see more
Actor | Writer | Director | Producer |

Entrepreneur

The browser extension will now display/overlay all the relevant information about
the contact on your TriSys database, directly inside the LinkedIn profile:

* (EHE @

TriS) Pm (RM v Acionsv @) v
m Q Search L= et I
Richard Branson
b e ==
Virgin Music mo

18 Contact Detils R

& Work E-Mail Richard Brans:
. Work Phone 01280 188205
0 Work Mobile 07252244187
0 Personal Mobile 07300 572857
See WhO'sVi§ & Home Phone 01823 131160
9 Address The Office Crawley Sussex, Londan, Londan, RH10 9NU,
[ United Kingdom
6 Website https://wwew.virgin.com/
Richard Branson - 3rd @ @ virgin Group
People Also Vie
Founder at Virgin Group Stowe School
B CVPreview -
Virgin Islands (British) - 16,218,165 followers - Contact info Barack
Former| 4L Requirements 0-
Americ
£ Placements Q-
Jennif;
About Bl Notes/Histary [
Actor |
Founder of the Virgin Group, which has gone on to grow successful businesses in sectors including mobile telephony. Entrepr  m scheguied Tasks B -
travel and transportation, financial services, leisure and entertainment and health and wellness. Virgin is a leading

intemational investment group and one of the world's most recognised and respected brands. Since startin: . sez mors N Jeff Weiner - 2na [
CEO at Linkedin
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You can also run Actions directly from within the extension pop-up:
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Selective Field Update

You may also selectively update the existing TriSys contact details with those
found on LinkedIn:

" =
®0oco0

This will reveal a window allowing you to update your TriSys database with
information found on the LinkedIn profile page:

&
L T

@ -
@
e @ i

B Scheduled Task ®-
Note the following key functionalities when updating an existing contact:

- You can edit the values shown on the left (those found on the Linkedin
profile) by clicking the editable text fields on the left

- You can click the “Search” spyglass icon “* where this icon is available,
allowing you to link the contact to an existing company within your TriSys
database

- You can selectively enable or disable the copy/update of a specific field by
using the switch button ® which is ON by default for all fields, allowing
you to turn off specific field updates where an update is not required

- The “Update TriSys” will update the database record with the specific
information you have provided as shown on the left

- Where additional fields exist, a vertical scrollbar will be displayed allowing
you to also selectively edit/update those fields
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TriSys Apex Automatic Browser Tab Focus

When using TriSys Apex, you can automatically display database records when
interacting with a LinkedIn profile.

In order for this display of database records to happen automatically, instead of
logging into TriSys Apex using https://apex.trisys.co.uk please login using
https://your-company-name.trisys.co.uk (where “your-company-name” is the
hyphenated name of your company, which can be found by logging into

https://support.trisys.co.uk with your TriSys credentials).

Add new contact from GMail message

The TriSys browser extension also allows you to import contacts from GMail and
display contact information when you are reading a GMail message and the
sender of the message exists within your TriSys database (this works based on the
senders’ email address, which can match either the personal and/or work email
address of the contact in TriSys).

When reading a message in Gmail, click the TriSys browser extension icon once.

If the sender contact does not exist in TriSys, you can add the contact using “Add
New Contact”, alternatively you can use “Assign to Existing Contact” should you
wish to assign an e-mail address to a contact already on your database, as well
as other contact details automatically extracted from the e-mail message.

< C & mailgooglecom Ak EEHE @

L Trisys ® rsdv § Semngsv

© apras ook (R[] g LEACEl @b
iAz.J‘ mmw Q -]

The functionality available with the TriSys browser extension for Gmail is identical
to that which is available for Linkedin.
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